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INSTALLATION:

The WPtools can be used in two ways: Memory Resident or Load on Demand.

Memory Resident:  The tools are loaded into memory when Excel is started.  This uses 500-700 KB of RAM in addition to what Excel requires.  The custom toolbars and the WPtools menu change in a context sensitive manner when the tools are Memory Resident.

Load on Demand:  The tools are only loaded into memory when one of the custom toolbar buttons is used.  The toolbars will not change in a context sensitive manner until after a tool is used.  The WPtools menu will not appear until after a tool is used.

To install the tools as a Memory Resident Add-in to Excel:

· Copy the files WPTOOLS.XLA and WPtools.prf from the WPtools Disk to your hard disk or network drive.

· Launch Excel on the machine on which to install the tools.

· From the Tools menu choose Add-Ins...

· Select the Browse button...

· From the Browse dialog box select WPTOOLS.XLA from your hard disk or network drive.

· Click OK

To install the tools as a Load on Demand Add-in to Excel:

· Copy the file WPTOOLS.XLA and WPtools.prf from the WPtools disk to your hard disk or network drive.

· Launch Excel

· Choose Open from the file menu.

· Open the file WPTOOLS.XLA from your hard disk or network drive.

The WPtools are now installed on your computer and will be available each time you launch Excel 97.  

NETWORK INSTALLATION NOTE:

If you have installed the WPtools from a write protected network drive there are two issues with the WPtools preferences.

· The Preferences dialog box for the WPtools will not have a Save Preferences button.  Any changes made to the WPtools preferences will affect only the current Excel session.

· The file WPtools.prf contains the default settings for the WPtools.  Therefore, setting up the WPtools.prf file on a network drive ensures that the WPtools operate in the same way every time they are started.

RE-INSTALLING:

If you ever need to reinstall the WPtools from another location on your hard disk or network drive it is recommended that you perform a complete Uninstall  as described below.  Then follow the directions on the previous page for creating a memory resident or load on demand installation. 

UNINSTALLING:

If you ever wish to uninstall the WPtools:

· From the Tools menu in Excel choose Add-Ins... (Memory Resident only.)

· Deselect WPtools from the Add-Ins Available box. (Memory Resident only.)

· From the View menu in Excel choose Toolbars.

· Delete the WP Active Chart and the WP Standard Toolbars.

· Delete WPTOOLS.XLA from your hard disk or network drive.

· Delete the file WPTOOLS.PRF from your hard disk or network drive.

INTRODUCTION:

The WPtools are designed to extend the functionality of Excel 97 to facilitate ways that it is commonly used in a laboratory based science curriculum.  The tools simplify tasks such as:

· Creating XY Scatter Plots with title, axis and series labels.

Scatter Plot tool

· Manipulation and analysis of XY Scatter Plots.

XY Coordinate tool

Rotate Format tool

Title and Label tool

Data Zoom tool

· Overlaying multiple XY Scatter Plots.

Overlay Plots tool

· Translating Excel spreadsheet formulas into symbolic representations

Formula Translator tool

· Fitting polynomial functions to experimental data.

Linear Fit tool

Polynomial Fit tool

The tools which provide this extended functionality are accessed in two ways:

· The custom WPtools menu which is added to Excel’s menu bar.







WPtools menu for worksheets.
WPtools menu for chart sheets.

· Two custom toolbars:  WP Standard and WP Active Chart.

WP Standard - Contains all of the tools that can be used when a worksheet is active.




The formula translator, scatter plot, overlay plots, linear fit and polynomial fit tools.

WP Active Chart - Contains all of the tools that can be used when a chart is active.




The overlay plots, xy coordinate, rotate format, title and labels, data zoom, restore plot axis, linear fit and polynomial fit tools.

The MENU And TOOLBARS:

Menu Only Options:

The WPtools menu provides two options that are not found on either of the toolbars:

· About WPtools... 

· Preferences...

About WPtools...:


The about WPtools... option displays a dialog box which provides general information about the Workshop Physics tools.

Preferences...:


The Preferences... option displays the WP Tools Preferences dialog box.  This dialog box controls several defaults that affect the way the tools perform.

· Toolbars Preferences:

Pop Up - The toolbars will automatically change from the WP Standard toolbar to the WP Active Plot toolbar when the user switches from a worksheet to a plot and vice versa.

Manual - No automatic toolbar changes will take place.  The user must manually display the toolbars if they want to use them.  In this mode a visible toolbar will remain visible for both worksheets and charts.

NOTES:  

I. Due to a bug in the IBM version of Excel 5.0 when “Pop Up” toolbars are used the text contents of the clipboard are cleared each time the toolbar changes.  Therefore, if “Pop Up” toolbars are used it is not possible to copy data on a worksheet and then switch to a chart and paste the data.  Likewise, it is not possible to copy a chart from a chart sheet and switch to a worksheet and paste it.  However, data can be copied from one worksheet and pasted to another worksheet or to a chart may be copied and pasted onto another chart.  Also, embedded charts may be copied and pasted among worksheets with no difficulty.  If it is necessary to copy data from a worksheet to a chart or vice versa use the "Manual" toolbars preference.
II. The WP Standard and WP Active Chart toolbars can be manipulated exactly like any of the built in Excel toolbars.  The tools may be copied to other toolbars and new tools can be added to the toolbars.

· Plots Preferences:

Place plots on worksheet - If “Place plots on worksheet” is checked all plots generated by the Scatter Plot and Curve Fitting tools will all appear on the active worksheet (termed “On Sheet Plots”).  The upper left-hand corner of the plot will be located at the upper left-hand corner of the first X data cell.  The size of the plot is specified in the "On Sheet Plots" group box in the preferences.  If “Place plots on worksheet” is not checked the plots generated will appear on a new chart sheet that will be added to the current workbook (termed “New Sheet Plots”).  If there is a title specified for the plot it will appear on the sheets name tab (note: a unique number will be appended to the title).  If no title is specified a generic title will appear (WPsheet #).

On Sheet Plots - Group box that contains a "Plot Height" and a "Plot Width" field.  The numbers in these boxes specify the height and width, when printed, of the generated plot (in inches) if the "Place plots on worksheet" box is checked.  These fields are only available for editing if the "Place plots on worksheet" box is checked.  These fields have no effect on New Sheet plots.

Grid lines on plots - If checked all plots will appear with major unit gridlines.  The spacing of the grid lines is determined automatically by Excel.  This setting applies to both On Sheet and New Sheet plots.

Use ordered selections - If checked (termed “Ordered Selections”) the leftmost column of the first multiple selection becomes the x-axis values.  All other columns become y-axis values.  If not checked (termed “Unordered Selections”) the leftmost column of all selections becomes the x-axis values.  (i.e. the order in which the columns are selected is ignored.  This is the standard method used by Excel.)  This setting applies to both On Sheet and New Sheet plots.

· Curve Fitting Preferences:

Fit Equation on plot - A graphic representation of the fit equation and the values of the fit coefficients will appear in text boxes on the plot.

Fit Statistics on plot- A text box containing the standard errors of each of the fit coefficients will appear on the plot.  A text box containing the R2 and  statistics will appear on the plot.

Copy Plot to fit worksheet - A copy of the plot will appear on the fit worksheet that is added to the workbook when any Curve Fitting tool is used.

· Formula Translator Preferences:

Characters in translation: - Indicates the number of characters from each of the symbolic names that should be used when creating the mnemonic representation of the worksheet formula.

WP Standard Toolbar:

This toolbar is only active if a worksheet is active.  The tools on this toolbar allow plots to be generated, functions to be fit to data and Excel formulas to be translated into symbolic notation.  The following tools are found on the WP Standard toolbar.  These tools also appear on the WP Tools menu when a worksheet is the active sheet.
Formula Translator:


Converts cell references in the Excel formula of the active cell into symbolic names obtained from the spreadsheet.  The formula is then displayed in a dialog box.

Cell references are translated as follows:

· Relative References - When a relative reference is found in the Excel formula the column and the row containing the active cell is searched starting with the active cell and moving upward and to the left until the first cell containing text (i.e. a label) is found.  If labels are found in both locations the label nearest to the active cell is used.  If the labels are equal distant to the active cell the label to the top is used.  If no label is found the cell reference will appear in the translated formula.

· Absolute References - When an absolute reference is found in the formula both the row and column containing the active cell are searched starting with the active cell and moving left/upward until the first label is found in each direction.  If a label is found in only the row or the column then it is used.  If labels are found in both locations the label nearest to the active cell is used.  If the labels are equal distant to the active cell the label to the left is used.  If no label is found then the reference will not be translated.

NOTES:

I. It is recommended that labels do not contain characters that are also mathematical operators (+, -, * etc..).  For example the label Y-One may appear in the translated formula as f(X)=Y-One*g(X). which appears to have an entirely different meaning than what was intended.

II. Any text following a ( in a cell label, such as units in expressions like Velocity(m/s), will be dropped from the label when it is translated.  This is done for reasons of readability.

Scatter Plot:


Quickly generates an X-Y scatter plot from the current selection(s).  Plot title and axis labels are added to the plot automatically if entered in an appropriate format (see below).

· Data Format - The table below illustrates the locations of the plot title, x-axis label, y-series labels, and their relation to the data.  If multiple selections are used the series do not need to appear in adjacent columns.  However, the title must always appear above the x-label, the x-label must appear above the x-data.  Also, each y-series label must appear above the data for that series.  The plot title, x-axis label and y-series labels that appear on the scatter plot are hot linked to their worksheet cell.  Therefore, changes to the cells containing the title or labels are reflected immediately on the scatter plots.
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· Selections - The plot is generated from the active selection(s) when the Scatter Plot tool is clicked.  A minimum of two columns of data must be selected (X-Series and Y-Series) to use the Scatter Plot tool.  The selection(s) may contain the title and series labels if desired, but it is not necessary.  The title and labels will appear on the graph as long as they are not separated from the data by any blank rows of cells.  If multiple selections are used each selection of the multiple selection should contain the same number of rows.  If selections have different numbers of rows all selections are truncated to the length of the shortest selection and the plot is generated.  When using multiple selections the order in which the series are selected may be important (see Preferences above).

· Automatic Title and Label Use:

No titles and labels - The worksheet area containing the selection does not have a title or any labels in the proper locations.  (The worksheet area is the block of non-blank cells which surround the selection, any cells separated from the selection by a blank row or column of cells is not in the same worksheet area as the selection.)  The plot is generated with no title, axis labels, or legend.

Labels with 1 y-series - The worksheet area containing the selection has only x-axis and y-series labels but no title and contains exactly 1 column of y-series data.  The plot is generated with both x-axis and y-axis labels.  There is not a title or a legend.

Labels with multiple y-series - The worksheet area containing the selection has only x-axis and y-series labels but no title and contains more than 1 column of y-series data.  The plot is generated with an x-axis label and a legend.  No plot title or y-axis label appears on the plot.

Title and Labels with 1 y-series - The worksheet area containing the selection has a plot title, x-axis and y-series labels and contains exactly 1 column of y-series data.  The plot is generated with a plot title and both x-axis and y-axis labels.  There is not a legend on the plot.

Title and Labels with multiple y-series - The worksheet area containing the selection has a plot title, x-axis and y-series labels and contains more than 1 column of y-series data.  The plot is generated with a plot title, an x-axis label and a legend.  There is not a y-axis label on the plot.

Overlay Plots...:


Copies the data series from one or multiple scatter plots (the source plots) onto another scatter plot (the destination plot).

· Source Plots selection - The source plots selection must contain all of the embedded charts or chart sheets from which the data series will be copied.  The source plots selection must be made before choosing the overlay plots tool.  Multiple embedded charts or chart sheets can be selected by holding shift and clicking on each embedded chart or chart sheet tab that you want to include.

· First Overlay Plots Dialog - After choosing the overlay plots tool a dialog box will appear instructing you to select the destination plot.  The destination plot is the embedded chart or chart sheet on which you want to overlay the data series from the source plots.  After choosing OK the overlay plots tool will have the pressed look and the overlay plots option on the WP Tools menu will have a check mark next to it, this indicates that your source plots selection has been registered.  The overlay plots operation may also be canceled from this dialog box.

· Destination Plot selection - The destination plot selection is the embedded chart or chart sheet onto which the data series from the source plots will be copied.  After selecting the destination plot choose the overlay plots tool again.  The title and axis labels from the destination plot will appear on the overlay plot that is generated.

· Second Overlay Plots Dialog - When the overlay plots tool is chosen for the second time a dialog box will appear that provides control of the overlay operation.

Overlay Type:

Delete Original Plots - When this option is selected the source and destination plots will be deleted when the overlay plot is created.

Preserve Original Plots - When this option is selected the source and destination plots will be preserved when the overlay plot is created.

Overlay Location:

New Sheet - When this option is selected the overlay plot is created on a new chart sheet.

Active Sheet - When this option is selected the overlay plot is created as an embedded chart on the active worksheet.  This option is only available if the destination graph is an embedded chart.  The size of the overlay plot is determined by the plot height and plot width options set in the WP preferences.

NOTES:

I. Due to the inner workings of Excel when making the source plots selection it is possible to select multiple chart sheet or multiple embedded charts but not possible to select a mixture of embedded charts and chart sheets.  If data from multiple embedded charts is to be overlaid with data from multiple chart sheets:  If the resulting plot is to be on a chart new chart sheet, overlay all of the embedded charts onto a new chart sheet and then overlay the new chart sheet with all of the other chart sheets.  If the resulting plot is to be an embedded chart, overlay all of the chart sheets onto a new chart sheet and overlay all of the embedded charts onto a new embedded chart, then overlay the chart sheet with the new embedded chart.

II. The series markers of the destination plot and their colors remain the same on the overlay plot.  If the series markers of the source plots and their colors have not been changes since the plot was created they will be adjusted to unique values on the overlay plot.  However, if the formatting of the source plots has been changed (including using the Rotate Format Tool) it will not be altered when the overlay plot is created, this may result in multiple series with identical formatting on the overlay plot.

Linear Fit:


Generates a least squares best fit of an equation with the format:


f(x) = a0 + a1 x

to the selected data.  If a worksheet is active a scatter plot of the data is generated and a line representing the best fit is added to the plot.  If a plot is active a line representing the best fit is added to the active plot.  The fit equation and fit statistics may also be added to the scatter plot (see Preferences above).

· Selections:

With worksheet active - The plot and fit are generated from the active selection(s) at the time the Linear Fit tool is clicked.  A minimum of two columns of data must be selected (X-Series and Y-Series) to use the Linear Fit tool.  The selection(s) may contain the title and series labels if desired (but it is not necessary, see Scatter Plot tool above).  If multiple selections are used each selection of the multiple selection must contain the same number of rows.  When using multiple selections the order in which the series are selected may be important (see Preferences above.)  Also if multiple selections are made the least squares fit is generated for the first Y-series selected.

With Chart Active - The selection must be the data series on the active chart for which the least squares fit is to be generated.

· The <title> Fit# Worksheet:

When any of the fit tools are used a new worksheet is added to the active workbook.  The worksheet name will be the same as the name of the sheet containing the data from which the fit was generated with the word "Fit" and a unique number appended at the end.  This worksheet contains a table of fit coefficients, their values, their standard deviations, all of the fit statistics, the columns of x and y data that are used to generate the fit line, and possibly a copy of the fit plot (see Preferences above).

· The Fit Line:

The fit line is the line that appears on the scatter plot when any fit tool is used.  The fit line always contains 100 evenly spaced data points.  The name of the fit line is the name of the series that is being fit with the word "Fit" appended on the end.  Like the series names the fit series name is also hot linked to the original worksheet cell that contains the series name.

NOTES:

I. If multiple selections used for the X and Y data to be fit have different numbers of rows a dialog box indicating that the X and Y columns must have the same number of rows of data will appear and the fit will be aborted.  Note:  The same dialog may be seen when using the fit tools from a selected series on a graph if that series was created using X and Y columns with unequal numbers of rows.

II. All Scatter Plot tool preferences settings apply to the plot generated by the fitting tools.

III. All of the title and label conventions for the scatter plot tool also apply to the plot generated by the fitting tools.

IV. A minimum of 2 data points are required to use the Linear Fit Tool.

Polynomial Fit...:

Generates a least squares best fit to the selected data of an equation with the general format:


f(x) = a0 + a1 x + a2 x^2 + ... + a6 x^6 
or


f(x) = a0 + a1 1/x + a2 1/x^2 + ... + x6 1/x^6

If a worksheet is active a scatter plot of the data is generated and a line representing the best fit is added to the plot.  If a plot is active a line representing the best fit is added to the active plot.  The fit equation and fit statistics may also be added to the scatter plot (see Preferences above).

· Selections:

See selections under Linear Fit Tool.
· WP Polynomial Fitting dialog:

When the polynomial fit tool is selected the Polynomial Fit dialog box appears.  The order of the fit equation may be entered in the dialog box.  The fit order must be in the range [-6...-1,1...6].  Fit orders outside that range will not be accepted by the dialog box.  Entering the fit order and choosing OK generates the fit and the scatter plot.

· Advanced Options:

Choosing the "Advanced Options" button brings up the "Fit Term Selection" dialog box.  This dialog allows more control over the format of the fit equation.  Individual terms can be included or excluded from the fit by selecting or deselecting the checkbox beside each term.  For example: To force the intercept to zero, deselect the checkbox next to the a0 term.  There are also 3 terms where the user may specify the power of X that is to be fit.  These terms are included primarily to allow fitting of non-integer powers such as square roots or inverse square roots.  These terms also allow the fitting of single powers greater than 6.  Therefore if 7,8,9 are used for the powers of these terms a 9th order fit can be generated.  The amount of extrapolation of the fit line can also be specified in this dialog box.  The Fit Extension entries indicate the amount that the fit line will be extended below and above  the minimum and maximum X axis values of the data being fit.  The Fit Extension is expressed as a percentage of the range of the X axis values for the data being fit.

Notes: 


I. If just the a0 term is selected a line fit is produced with the slope of the line forced to zero.  This gives an estimate of the dc value of the function - or the mean of the data.

II. It is recommended that a minimum of n+1 rows of data be selected for an nth order fit.  If less than n+1 rows of data are selected the least squares problem becomes under constrained and the resulting fit will most likely be very poor.  When the least squares problem is underconstrained a dialog box appears warning that the resulting fit is likely to be very poor.

The WP Active Chart Toolbar:


This toolbar is only active if an X-Y Scatter plot is the active chart.  The plot may be on its own sheet or appear as an embedded object on a worksheet.  The tools on this toolbar allow the plot to be manipulated in various ways.  The following tools appear on the WP Active Chart toolbar and also on the WP Tools menu when a chart is active.

Overlay Plots...:


See the Overlay Plots tool section under the WP Standard toolbar heading.

Get Coordinates...:


The Get Coordinates tool returns the (x,y) coordinate pair of the currently selected point on the graph.  

Note:  

I. The selected point can be moved to adjacent points by using the left and right arrow keys on the keyboard.

Rotate Format:


The Rotate Format tool cycles the format of the plot series through a set of predefined formats.  If a series on the active plot is selected the format of that series is rotated.  If no series is selected then the format of all of the series on the plot are rotated.  The set of formats and their order in the cycle are as follows:



Points only --> Line only



Line only --> Points and Line



Points and Line --> Points only

Notes:

I. If the current format of the series is one of the set of formats the tool will pick up the cycle at the appropriate point.

II. If the current format is not one of the set of formats the tool will format the series as Points only.  

Edit Labels...:


The Edit Labels tool provides a dialog box for specifying a new plot title, x axis label, and y axis label.  If the plot currently has a title and/or labels they appear in the fields of the dialog box for editing.

Note:

I. This tool removes the hot links between the title and axes labels and the original worksheet data and replaces them with the text entered in the edit boxes.  Therefore, this tool may be used to decouple the title and labels of old plots from the worksheet if new plots being created need a different title and labels.

Data Zoom...:


Changes the X and Y axis boundaries on a plot enabling the user to zoom in on important data.

· The first click on this tool creates a "WP Zoom Rectangle" on the plot.  The rectangle can be resized by moving the object handles.

· If a "WP Zoom Rectangle" is present and the tool is clicked the plot scales are adjusted to match the boundaries of the "WP Zoom Rectangle".  The boundaries of the "Zoom Box" are rounded to the nearest minor unit of the plot as follows:

The top (right) of the "Zoom Box" is rounded up to the next higher minor unit.  

The bottom (left) of the "Zoom Box" is rounded down to the next lower minor unit.

· The data zoom tool is canceled by deleting the "WP Zoom Rectangle".  Do this by clicking on the rectangle and pressing the delete key.

Notes:

I. After the Data Zoom tool is used the automatic determination of minor units is turned on.  (See the Scale tab in the Format Axes dialog box by double clicking on the axis of a graph.)

Restore Plot Axes:


Restores the X and Y axis scaling to automatic.  This tool undoes the effects of all of the data zooms that have been done.

Notes:

I. After the Restore Plot Axes tool is used the automatic determination of minor units is turned on.  (See the Scale tab in the Format Axes dialog box - double click on the axis of a graph.)

Linear Fit:


See the Linear Fit tool section under the WP Standard toolbar heading.

Polynomial Fit...:


See the Polynomial Fit tool section under the WP Standard toolbar heading.
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